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RNA 9000 Purity & Integrity キット

RNA 9000 Purity & Integrity キットには、サンプル調製用の試薬と消耗品、および RNA フラグメン
トをサイズごとに分離し、RNA 調製物中に存在する可能性のある不均一性と不純物を定量するた
めの方法が含まれています。

このドキュメントでは、RNA 9000 Purity & Integrity キットを使用したサンプル調製について説明し
ます。また、PA 800 Plus ソフトウェアを使用したデータ収集とデータ分析の手順も説明します。

このアプリケーションガイドの情報は、出発点としてご利用ください。必要に応じて、注入時間、電
圧、注入タイプ、その他のパラメータを変更し、最適な条件を探し出してください。

注: システムを安全に使用する手順については、次のドキュメントを参照: システム概要ガイド。

安全性
原料と試薬の適切な取り扱いに関する情報については、sciex.com/tech-regulatory で入手可能な
安全データシート (SDS) を参照してください。標準的なラボの安全ガイドラインに常に従ってくださ
い。有害物質情報については、次のセクションを参照: 有害物質情報。

使用目的
RNA 9000 Purity & Integrity は、ラボ専用です。

はじめに
RNA 9000 Purity & Integrity キットは、次世代 RNA 治療に取り組むバイオ医薬品科学者向けに
設計されています。このキットは、高い分析分解能を提供し、メソッドの複雑さを軽減し、移植性を簡
素化します。このキットは、PA 800 Plus システムと BioPhase 8800 システムの両方で検証されて
います。

この方法論では、RNA サンプルを熱変性させた後、氷水浴で直ちに冷却します。これにより、核酸
は分離中に最も一貫した移動性を提供する構造に強制的に取り込まれます。

RNA サンプルは、交換可能なポリマーゲルを含むベアフューズシリカキャピラリー内でサイズによ
って分離され、同時に逆電気浸透流（EOF）を制限しながらふるい分け選択性を提供します。蛍光
標識色素 SYBR™ Green II RNA Gel Stain は 1 試薬の調製中にポリマーゲルマトリックスに添加
されます。この色素は RNA 分子に優先的に結合するため、RNA は分離中にレーザー誘起蛍光
（LIF）によって検出されます。

1 SYBR™ は、Life Technologies Corporation の商標です。SYBR™ Green II RNA Gel Stain は再販不可です。
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ワークフロー

表 1 : RNA 9000 Purity & Integrity キットワークフロー

ステップ 実行する作業 次を参照

1 RNA サンプルは 50 ng/mL ~ 50 μg/mL
の濃度で調製します。

ラボの RNA 調製手順。

2 （オプション）ssRNA Ladder を Sample
Loading Solution またはヌクレアーゼフリ
ー水で希釈し、70°C で 5 分間変性させた
後、直ちに冷却します。

ssRNA Ladder を調製

3 各 RNA サンプルを Sample Loading
Solution またはヌクレアーゼフリー水で希
釈し、70°C で 5 分間変性させた後、直ち
に冷却します。

RNA サンプルの調製

4 LIF 検出器を取り付けます。 LIF Detector のインストール

5 サンプルトレイをロードします。 サンプルトレイのロード

6 カートリッジを取り付けます。 カートリッジの取り付けおよび検出器のキ
ャリブレート

7 ゲル緩衝液を準備し、緩衝液トレイをロー
ドします。

緩衝液トレイをロードする

8 PA 800 Plus ソフトウェアのユーザーは、
RNA 9000 装置とプロジェクトを作成してく
ださい。

サンプル装置を作成およびサンプルプロ
ジェクトを作成する

9 PA 800 Plus ソフトウェアでシーケンスを
作成し、実行を開始します。シーケンスが
シャットダウンメソッド - RNA 9000 メソッド
で終了していることを確認します。

シーケンスを作成して実行を開始する

10 実行後、カートリッジを保管します。 カートリッジを保管する

11 データを分析します。 データの分析

必要装置および材料

注: 再注文部品番号の付いたアイテムの場合、再注文数量はキット数量と異なる場合があります。

注: RNA 9000 Purity & Integrity キット (PN C48231) は、核酸拡張範囲純度および完全性キット
(PN 5087900) と ssRNA Ladder (0.05 ～ 9 kb) (PN 5088699) の 2 つの部分としてパッケージ化
されています。どちらの部品も別々に注文することはできません。

注: RNA 9000 Purity & Integrity キット（PN C48231）内の ssRNA Ladder は、他のキットコンポ
ーネントとは別に出荷されます。
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表 2 : RNA 9000 Purity & Integrity キット（PN C48231）

コンポーネント 数量 再注文部品番号

核酸拡張レンジ純度&完全性キット(PN 5087900) 該当なし

Acid Wash/Regenerating Solution (0.1 M HCl) (100 mL) 1 該当なし

CE Grade Water（140 mL） 2 C48034

LIF Performance Test Mix（20 mL） 1 726022

Nucleic Acid Extended Range Gel（140 mL） 2 該当なし

SYBR™ Green II RNA Gel Stain2 （500×）（0.11 mL） 7 該当なし

ssRNA Ladder (0.05-9 kb) (PN 5088699) 該当なし

ssRNA Ladder（0.05 kb ～ 9 kb）(70 μL)（別に出荷） 2 該当なし

表 3 : SCIEX の追加材料

コンポーネント 数量 部品番号

（オプション）Capillary Performance Run Buffer A 1 338426

キャピラリー、ベアフューズドシリカ（内径 50 μm × 長さ 67
cm）

1 338451

キャピラリーカートリッジ、ブランク 1 144.738

キャピラリーカートリッジ、組み立て済み 1 A55625

フィルター、520 nm 発光フィルター 1 144.940

LIF カートリッジアパチャプラグアセンブリ 1 721.125

LIF カートリッジプローブガイドアセンブリ 1 721.126

PCR Universal Vial（200 µL） 100 144709

Sample Loading Solution 6 mL 608082

Universal Vial キャップ、ブルー 100 A62250

Universal Vial 100 A62251

表 4 : 追加の必要な試薬または材料

説明 ベンダー 部品番号

0.45 μm の細孔径膜を持つ　Acrodisc 32 mm シリンジフィ
ルター

Pall 4654

Luer-Lok チップディスポーザブルシリンジ（10 mL） BD 309604

2 SYBR™ は、Life Technologies Corporation の商標です。SYBR™ Green II RNA Gel Stain は再販不可です。
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表 4 : 追加の必要な試薬または材料 (続き)

説明 ベンダー 部品番号

（オプション）ヌクレアーゼフリー水（10 × 2 mL） Integrated DNA
Technologies

11-04-02-01

（オプション）RNaseZap RNase 除染液（250 mL） Thermo Fisher
Scientific

AM9780

保管条件

• 受領後、次のものを 2 °C 〜 8 °C で保管します。

• Nucleic Acid Extended Range Gel

• LIF Performance Test Mix

• 受領後、直ちに SYBR™ Green II RNA Gel Stain3 をアルミホイルで包んで SYBR™ Green II
RNA Gel Stain のフォトブリーチングを抑え、-35 ℃ ～ –15 °C で保管します。

• 受領後、ssRNA Ladder を -35 °C 〜 -15 °C で保管します。

• 残りのキットの内容は室温で保管してください。

顧客が用意する装置および材料

• パウダーフリー加工の手袋（ネオプレンまたはニトリル製のものを推奨）

• 安全メガネ

• ラボ用白衣

• PCR チューブ、0.2 mL flat-cap ヌクレアーゼフリー（VWR USA PN 20170-012 または VWR
EUR PN 732-0548）

• テーブルトップ小型遠心分離機

• マイクロ遠心分離機または同等品、およびヌクレアーゼフリー微小遠心分離機

• ボルテックスミキサー

• ピペットと適切なヌクレアーゼ フリーのヒント。

• 37 °C ～ 100 °C の温度に対応したウォーターバスまたはヒートブロック

• 分析バランス

• 氷

必要な検出器

488 nm の励起波長と 520 nm の発光フィルターを備えたレーザー誘起蛍光（LIF）検出器と、それ
を校正するための備品が必要です。キャリブレーションするための備品は次のとおりです。

• LIF Performance Test Mix、キットに同梱

3 SYBR™ は、Life Technologies Corporation の商標です。SYBR™ Green II RNA Gel Stain は再販不可です。
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• CE Grade Water、キットに同梱

必要なカートリッジまたはキャピラリー

注意: 結果が不正確になる可能性。キャピラリーを RNA 9000 Purity & Integrity キットで使用し
ている場合、同じキャピラリーを他の用途に使用しないでください。異なる緩衝液とサンプルタイプを
混合すると、サンプルのキャリーオーバー、非特異的結合、および分離不良が発生する可能性があ
ります。

次のいずれか:

• 組み立て済みカートリッジ (部品番号 A55625)

• キャピラリーカートリッジ（部品番号 144738）およびキャピラリー、ベアフューズドシリカ、内径 50
µm（部品番号 338451）

キャピラリーの調整

注意: 結果が不正確になる可能性。塩基性溶液を使用してキャピラリーを洗浄しないでください。塩
基性溶液はキャピラリー壁をマイナスイオン化し、サンプルとの非特異的相互作用を引き起こす可
能性があります。これらの相互作用により、分離不良やサンプルの劣化が生じる可能性がありま
す。

• キャピラリを初めて使用する前に、コンディショニングメソッド - RNA 9000 メソッドを使用してキャ
ピラリーを調整します。

メソッドとシーケンス
sciex.com/products/methods からメソッドとシーケンスをダウンロードします。メソッドとシーケンス
は、32 Karat ソフトウェアを使用して手動で作成することもできます。次のセクションを参照: メソッ
ド。

メソッドを PA 800 Plus コントローラ: C:\32Karat\projects\RNA 9000\Method に保存しま

す。

シーケンスを C:\32Karat\projects\RNA 9000\Sequence に保存します。

本書発行の時点では、以下のメソッドおよびシーケンスが SCIEX の Web サイトで入手できます。

• メソッド:

• コンディショニングメソッド - RNA 9000: キャピラリーを調整します。

• 分離メソッド - 動電注入 - RNA 9000: サンプルの動電注入を使用してサンプルを分離しま
す。

• シャットダウンメソッド - RNA 9000: シーケンスの最後にキャピラリーをクリーニングし、光源
をオフにします。

• キャピラリーリンス - RNA 9000: キャピラリーを洗浄します。キャピラリのコンディショニング
後に時間を節約するには、シーケンス内のコンディショニングメソッド - RNA 9000 をこのメソ
ッドに置き換えます。

RNA 9000 Purity & Integrity キット

アプリケーションガイド
RUO-IDV-05-13437-JA-C

RNA 9000 Purity & Integrity キット PA 800 Plus
Pharmaceutical Analysis システム用

9/49

https://sciex.com/products/methods


• ANALYSIS - RNA 9000 - ssRNA Ladder: ssRNA Ladder の分析に役立つデフォルトの積
分パラメータと名前付きピークが含まれています。

• RNA 9000 テストシーケンス - 動電サンプル注入: 動電サンプル注入を用いた分離メソッドによ
るシーケンス。

サンプルの調製

RNA を扱うためのベストプラクティス

RNA の分析を成功させるためには、RNase 汚染の制御が重要です。ssRNA Ladder や RNA サ
ンプル分離の前に、RNA の完全性を確保するための注意が必要です。RNase はヒトの皮膚、発
汗、唾液のほか、細菌や真菌の胞子に広く存在しているため、ラボ環境に普遍的に存在していま
す。適切なラボの手順は、RNase からの RNA 分解を制御するのに役立ちます。

1. RNA サンプルを扱うときは、常に手袋を着用し頻繁に交換してください。

2. RNase フリーのラボエリアを指定し、ベンチ表面、実験ラック、マイクロピペッターには、
RNaseZap Rnase 除染液や MP Bio RNase Erase 除染液などの Rnase 除染試薬を使用し
ます。また、RNase 汚染を制御するために、紫外線消毒が可能なラボ装置を使用してくださ
い。

3. RNA 使用専用のピペットを使用し、クロスコンタミネーションを減らすために、ヌクレアーゼフリ
ーと認定されたフィルター付きピペット チップを使用します。

4. RNA と接触するものには、ヌクレアーゼ フリーのプラスチック製バイアルと実験器具を使用し
てください。RNA を添加する前に、空気の流れの制限領域で覆い、作業することにより、環境
汚染からプラスチック製品を保護します。

5. RNA サンプル調製時には、ヌクレアーゼフリー水などの試薬を使用してください。RNA サンプ
ル調製時に Sample Loading Solution または脱イオン ホルムアミドを使用すると、RNA を安
定化させ、RNase による RNA 分解を防ぐ環境が促進されます。

注: CE Grade Water はヌクレアーゼフリーとして認定されていません。

ssRNA Ladder を調製

注: 未知の RNA サンプルのサイズを推定するための定性的な基準として ssRNA Ladder を使用
します。定量的な基準を意図したものではありません。

1. ssRNA Ladder を調製します。

a. 最初の実行では、ssRNA Ladder のバイアルを冷凍庫から取り出し、氷上で解凍します。

b. ボルテックス ミキサーを使用して、数秒間簡単に混合してから、遠心分離機を使用してバ
イアルを数秒間回転させ、溶液をバイアルの底に移動させます。

c. 8μL ずつに分けた溶液を測定し、ヌクレアーゼ フリー PCR バイアルに入れます。

d. 1 分割量を取り分け、残りの分割量を –35 °C 〜 –15 °C で保存します。

2. ssRNA Ladder の 8 μL 分割量のうち 1 つを使用します。凍っている場合は氷上で解凍してか
ら使用してください。
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3. 50 μL の RNA サンプルごとに、2 μL の ssRNA Ladder を 48 μL の Sample Loading
Solution またはヌクレアーゼフリー水に加えます。

4. サンプルを 70 ℃ で 5 分間加熱します。

5. 5 分後、すぐに混合物を水浴に入れ、氷水につけて 2 分以上冷やします。

注: 急冷することで、RNA は最高の分離結果が得られる構造になります。

6. マイクロバイアルをユニバーサルバイアルに入れ、ユニバーサルバイアルをサンプルトレイに
入れます。

7. ピペットを使用して、冷却した RNA 溶液の 50 μL ～ 200 μL をマイクロバイアルに加え、ユニ
バーサルバイアルを青色キャップで封止します。

8. サンプルトレイをシステムにセットします。サンプルコンパートメントの温度が 10 °C に設定され
ていることを確認します。

注: レーザー誘導蛍光のレーザーが温まっていない場合、または検出器がキャリブレートされ
ていない場合は、サンプルトレイをシステムにセットしないでください。代わりに、レーザーを温
める間、またはキャリブレーションを行う間は、トレイを 2 °C ～ 8 °C の間で保管し、その後、サ
ンプルトレイをシステムにセットしてください。

RNA サンプルの調製

1. RNA アリコートを氷上で解凍します。

RNA が分解されるのを防ぐために、サンプルを冷却しておきます。

2. RNA サンプルを Sample Loading Solution またはヌクレアーゼ フリー水で 50 ng/mL ~
50 μg/mL 間で調製します。

RNA 濃度は、1 μg/mL ~ 5 μg/mL を推奨します。

注: より高いサンプル濃度を使用する場合は、分離メソッドの LIF Detector Initial Conditions
タブで Dynamic range を 100 から 1,000 に増やします。

3. サンプルを 70 ℃ で 5 分間加熱します。

4. 5 分後、すぐに混合物を水浴に入れ、氷水につけて 2 分以上冷やします。

注: 急冷することで、RNA は最高の分離結果が得られる構造になります。

5. マイクロバイアルをユニバーサルバイアルに入れ、ユニバーサルバイアルをサンプルトレイに
入れます。

6. ピペットを使用して、冷却した RNA 溶液の 50 μL ～ 200 μL をマイクロバイアルに加え、ユニ
バーサルバイアルを青色キャップで封止します。

7. サンプルトレイをシステムにセットします。サンプルコンパートメントの温度が 10 °C に設定され
ていることを確認します。
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注: レーザー誘導蛍光のレーザーが温まっていない場合、または検出器がキャリブレートされ
ていない場合は、サンプルトレイをシステムにセットしないでください。代わりに、レーザーを温
める間、またはキャリブレーションを行う間は、トレイを 2 °C ～ 8 °C の間で保管し、その後、サ
ンプルトレイをシステムにセットしてください。

PA 800 Plus システム用の準備
このセクションの手順で、PA 800 Plus システムのデータ取得の準備をします。

このセクションの手順は、システムがすでに適切にインストールされ、初期化されていることを前提
としています。

ヒント! 時間を節約するには、実行開始の 30 分前に光源をオンにしてウォームアップします。

LIF Detector のインストール

1. PA 800 Plus システムの電源を切り、LIF 検出器を取り付けます。次のドキュメントを参照: シ
ステムメンテナンスガイド。

2. システムの電源を入れます。

3. レーザーの電源を入れ、ランプが暖まるまで少なくとも 30 分間待ちます。

インターフェースブロックをクリーニングする

注意: システムに損傷を与える恐れ。ゲルが電極、開口レバー、キャピラリーの端、およびインター
フェイスブロックに溜まらないようにしてください。ゲルが蓄積すると、キャピラリーの破損、電極の曲
がり、バイアルの詰まり、注入の失敗につながる可能性があります。

使用後または化学薬品の交換時に、電極、開口レバー、キャピラリー端、およびインターフェースブ
ロックをクリーニングしてください。詳細な手順については、次のドキュメントを参照: システムメンテ
ナンスガイド。

ゲル緩衝液は非常に粘性が高く、定期的かつ徹底的な洗浄を行わないと、システム内に溜まる可
能性があります。

カートリッジの取り付けおよび検出器のキャリブレート

注: 分析結果が長期間にわたって一貫していることを確認するために、SCIEX では、検出器を PA
800 Plus システムに取り付けるたびに校正することをお勧めします。また、カートリッジ内のキャピ
ラリーを交換したり、別のカートリッジを取り付けた後に、検出器のキャリブレーションを行います。

1. カートリッジを箱から取り出し、必要に応じてキャピラリーを取り付けます。

2. カートリッジからアパチャ（開口部）を取り外し、レーザー誘導蛍光検出器にレーザー誘導蛍光
アパチャとプローブガイドを取り付けます。次のドキュメントを参照: システムメンテナンスガイ
ド。

3. カートリッジを PA 800 Plus システムに取り付けます。次のドキュメントを参照: システムメンテ
ナンスガイド。
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4. 検出器をキャリブレートします。

Instrument Configuration ダイアログから利用できる Calibration ウィザードを使用します。（こ
れは 32 Karat ソフトウェアで行う手順です。)詳細な情報については、次のセクションを参照:
レーザー誘導蛍光検出器のキャリブレーション。

Calibration ウィザードのステップ 2 で、次の表の値を使用します。

注: Target RFU は 40 であるため、PA 800 Plus システムからの信号強度は BioPhase
8800 システムからの信号強度とほぼ同じになります。これは、転送可能性を目的としていま
す。

表 5 : キャリブレーションパラメータ

Detector Channel 1

Target RFU 40

Capillary Dimensions

Internal Diameter 50 µm

Total Length キャピラリーの長さに応じて、30 cm または
50 cm

緩衝液トレイをロードする

注意: システムに損傷を与える恐れ。1.8 mL を超える液体をバイアルに入れないでください。また、
廃液バイアルには 1.8 mL を超えて溜まらないようにしてください。バイアルの容量が 1.8 mL 以上
が含まれている場合、圧力ダメージを与える恐れがあります。

注: 気泡を防ぐには、ゲル緩衝液を振ったり、激しく混ぜたりしないでください。気泡は分離不良の
原因になることがあります。

注: SYBR™ は、Life Technologies Corporation の商標です。SYBR™ Green II RNA Gel Stain は
再販不可です。

1. 次の表に示す試薬をコニカルチューブに加え、20 回以上静かに反転させます。

チューブを反転させながら、泡が立たないことを確認します。

注意: 結果が不正確になる可能性。ゲル緩衝液は事前に準備しないでください。ゲル緩衝液に
含まれている SYBR™ Green II RNA Gel Stain が保管中に劣化し、強度の低いピークが発
生する恐れがあります。

表 6 : ゲル緩衝液（SYBR™ Green II RNA Gel Stain を使用した Nucleic Acid Extended
Range Gel）

試薬 1 ～ 8 サンプ
ルの場合

9 ～ 16 サンプ
ルの場合

41 ～ 48 サン
プルの場合

Nucleic Acid Extended Range Gel 5 mL 10 mL 30 mL
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表 6 : ゲル緩衝液（SYBR™ Green II RNA Gel Stain を使用した Nucleic Acid Extended
Range Gel） (続き)

試薬 1 ～ 8 サンプ
ルの場合

9 ～ 16 サンプ
ルの場合

41 ～ 48 サン
プルの場合

SYBR™ Green II RNA Gel Stain 10 μL 20 μL 60 μL

注: ゲル緩衝液と色素の混合物を本書では「ゲル緩衝液」と呼びます。

ヒント! 準備したゲル緩衝液の入ったバイアルをアルミホイルで包み、SYBR™ Green II RNA
Gel Stain のフォトブリーチングを抑えます

2. 0.45 μm Acrodisc シリンジ フィルターと Luer-Lok シリンジを使用して、ゲル緩衝液をフィルタ
ー処理します。

3. 次の図に示すように、16 本のユニバーサルバイアルを緩衝液トレイに入れます。各行は少なく
とも 8 回の実行に十分です。

注: 分離メソッドは、8 回の実施後に増加するようにプログラムされています。乾燥ゲルやその
他の化学物質で汚染されている可能性があるため、バイアルやキャップは再利用しないでくだ
さい。バイアルとキャップは 1 回使い切りです。

図 1 : 16 サンプル用の緩衝液トレイレイアウト

注: サンプル数が 8 未満の場合は、行 1 のみを記入してください。

4. 次の表に示すようにバイアルに充填します。各バイアルを充填した後、青いキャップでキャップ
します。次の図を参照: 図 2。
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表 7 : 準備するバイアル

図 1 のラベル バイアル数 容量/バイアル
（mL）

試薬

水 10 1.5 CE Grade Water

ゲル 6 1.5 SYBR™ Green II RNA Gel Stain のゲル
緩衝液

HCl 2 1.5 Acid Wash/Regenerating Solution

廃液 6 1.0 CE Grade Water

図 2 : Universal Vial とキャップのセットアップ

項目 説明

1 Universal Vial キャップ

2 最大充填ライン

3 Universal Vial

サンプルトレイのロード

1. マイクロバイアルをユニバーサルバイアルに入れ、ユニバーサルバイアルをサンプルトレイに
入れます。次の図を参照: 図 3。
位置 A1 は ssRNA Ladder 用です。他のサンプルには他の位置を使用します。
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図 3 : サンプルトレイレイアウト

2. バイマイクロバイアルにサンプルを追加します。各サンプルは次のとおりです。

a. または、50～200 μL のサンプルをナノバイアルに移動します。

b. Universal Vial に青いキップを取り付けます。次の図を参照: 図 4。

図 4 : サンプルバイアルのセットアップ

項目 説明

1 ユニバーサルバイアルキャップ
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項目 説明

2 マイクロバイアル

3 ユニバーサルバイアル

4 ユニバーサルバイアル内のマイクロバイアル

サンプルを実行する

最良の結果を得るためのヒント

SCIEX は、ssRNA Ladder の分離性能とその他の特性をさまざまな温度でテストしました。30 ℃
は、全体として最も良い結果が得られたため、分離方法に使用しました。

特定の特性を最大化したい場合は、他の温度を使用することも可能です。表 8 を参照してくださ
い。

表 8 : キャピラリー温度設定のガイダンス

キャピラリー温度
（°C）

キャピラリー実行寿
命

9 kb ピーク移動時
間（分）

RNA の長さによる最適な分解
能

3 kb ～ 5 kb ≥ 5 kb

25 最高 ~21

30 高 ~20

35 中 ~19

40 低い ~17

注: キャピラリー実行寿命（注入可能回数）は、サンプルと分離メソッドによって異なります。前の表
は、キャピラリーの温度によって性能がどのように変化するかを示しています。一般に、温度が低い
ほどキャピラリー実行寿命が長くなります。

リンスメソッドを使用

リンスメソッドは、キットの他のメソッドと一緒に提供されます。

キャピラリー調整後の時間を節約するために、シーケンスの コンディショニングメソッド - RNA 9000
メソッドを キャピラリーリンス - RNA 9000 メソッドに置き換えます。リンスメソッドはコンディショニン
グメソッドに比べ、約 30 分の短縮が可能です。

サンプル装置を作成

注: PA 800 Plus ソフトウェアを使用してデータの取得と分析を行う場合は、次の手順が必要です。
代わりに 32 Karat ソフトウェアを使用する場合、この手順は必要ありません。

この手順では、32 Karat ソフトウェアの管理権限を持つユーザーのユーザー名とパスワードが必要
です。
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詳細な手順については、次のドキュメントを参照: 32 Karat ソフトウェアヘルプ または メソッド開発
ガイド。

1. デスクトップの 32 Karat のアイコンをダブルクリックします。

2. Tools > Enterprise Login をクリックし、ユーザー名とパスワードを入力して Login をクリック
します。

3. Tools > System Administration Wizard をクリックします。

図 5 : 管理ウィザードのウィンドウを選択する

4. Instrument をクリックし、Next をクリックします。

5. ウィザードの指示に従って、装置を作成します。装置名の入力を求められたら、RNA 9000 と

入力します。
PA 800 plus System Configuration ダイアログが開きます。

6. LIF Detector、 、をクリックしてから OK をクリックします。

7. 次のいずれかの操作を行います。

• システムがコントローラに接続され、電源が入っている場合は、Auto Configuration をクリ
ックします。

• システムがコントローラに接続されていないか、電源がオフになっている場合は、
Configured modules リストで LIF Detector を右クリックし、Open を選択します。トレイ
が正しく構成されていることを確認してから、 OK をクリックします。

8. OK をクリックします。
PA 800 plus System Configuration ダイアログが閉じます。
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サンプルプロジェクトを作成する

注: PA 800 Plus ソフトウェアを使用してデータの取得と分析を行う場合は、次の手順が必要です。
代わりに 32 Karat ソフトウェアを使用する場合、この手順は必要ありません。

この手順では、32 Karat ソフトウェアの管理権限を持つユーザーのユーザー名とパスワードが必要
です。

1. デスクトップの 32 Karat ソフトウェアのアイコンをダブルクリックします。

32 Karat ソフトウェアがすでに開いている場合は、開いているすべての装置ウィンドウを閉じま
す。

2. Tools > Enterprise Login をクリックし、ユーザー名とパスワードを入力して Login をクリック
します。

3. Tools > System Administration Wizard をクリックします。

図 6 : 管理ウィザードのウィンドウを選択する

4. project クリックし、Next をクリックします。

5. ウィザードの指示に従って、プロジェクトを作成します。プロジェクト名の入力を求められたら、
RNA 9000 と入力します。

必ずユーザーをプロジェクトに割り当ててください。

詳細な手順については、次のドキュメントを参照: 32 Karat ソフトウェアヘルプ または システム
管理ガイド。

6. 必要に応じて、SCIEX web サイトからメソッドおよびシーケンスファイルをダウンロードします。
次のセクションを参照: メソッドとシーケンス。
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7. メソッドをプロジェクトのメソッドフォルダにコピーします。デフォルトでは、これは
C:\32Karat\projects\RNA 9000\Method です。

8. シーケンスをプロジェクトのシーケンスフォルダにコピーします。デフォルトでは、これは
C:\32Karat\projects\RNA 9000\Sequence です。

シーケンスを作成して実行を開始する

1. デスクトップの PA 800 Plus ソフトウェアアイコンをダブルクリックして、PA 800 Plus ソフトウェ
アを開きます。
PA 800 plus ウィンドウが開きます

2. ウィンドウ右上の （Run）をクリックします。
Instrument Status and Direct Control ページが開きます。

図 7 : 装置ステータスと直接制御ウィンドウ

3.  (Describe)をクリックします。

4. Application リストで RNA 9000 をクリックします。Sequence リストで、Browse をクリックし
た後、RNA 9000 テストシーケンス - 動電サンプル注入シーケンスを参照します。プロンプトが
表示されたら、ユーザー名とパスワードを入力します。
ページが更新され、選択したシーケンスが表示され、シーケンス内のすべての行がサンプルと
して指定されます。

5. 最初の行（ メソッド）をクリックして選択し、 Rows 領域の  (Control)をクリックしま
す。

最初の行には ssRNA Ladder が含まれます。
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シーケンスの最初の行の Type 列のアイコンが正方形に変わります。

6. 最後の行（シャットダウンメソッド - RNA 9000 メソッド）をクリックして選択し、Rows 領域の

（Always）をクリックします。
シーケンスの Type 列のアイコンが三角形に変わります。

図 8 : Describe sequence rows and columns ウィンドウ

7. ウィンドウの右下の (Save) をクリックしてから、 (Finish) をクリックします。

8. Number of samples フィールドで矢印ボタンをクリックして、実行のサンプル数を設定します。

図 9 : サンプル数の設定

サンプル数が変わると、右側の緩衝液とサンプルトレイの画像が更新され、正しい数のバイア
ルと実行の位置が表示されます。たとえば、図 1 では、8 つのサンプルに対して 1 行の試薬が
必要です。16 サンプルには 2 行の試薬が必要です。
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図 10 : トレイマップ

9. 緩衝液およびサンプルトレイがロードされていない場合は、 （Load）をクリックし、PA
800 Plus システムに緩衝液およびサンプルトレイをロードしてから、ドアを閉じます。

10.  (Next)をクリックし、Yes - run now (はい - 今すぐ実行)をクリックします。

図 11 : ロードされたサンプルのプロンプト
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図 12 : データ取得時の PA 800 ソフトウェア

廃棄物処理

警告! 生物学的または有害化学物質の危険。化学物質のバイアルおよびキャップ、お
よび調製したサンプルの残りを処分する際は、必要に応じて、地域の指令に従います。
これらには、規制化合物や生物学的危険のある物質が含まれていることがあります。

カートリッジを保管する

カートリッジを 24 時間未満保管する

1. シャットダウンメソッドを使用して、キャピラリーをクリーニングします。

シャットダウンメソッドでは、キャピラリーを CE Grade Water で満たし、カートリッジ内の温度を
15 ℃ まで下げます。

2. キャピラリーの両端を CE Grade Water のバイアルに浸した状態で、カートリッジをシステムに
最大 24 時間保管します。

カートリッジを 24 時間以上保管する

1. シャットダウンメソッドを使用して、キャピラリーをクリーニングします。

2. システムからカートリッジを取り外します。
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3. キャピラリーの両端を CE Grade Water のバイアルに浸した状態で、カートリッジをカートリッジ
保管ボックスに入れます。

4. カートリッジ保管ボックスを 2 °C から 8 °C の冷蔵庫に直立させて保管します。

保管後のカートリッジを準備する

• カートリッジを 1 日以上使用していないか、または長期間保管していた場合は、CE Grade
Water を使用して 50 psi で 5 分間洗浄し、キャピラリーを調整します。

データの分析

ssRNA Ladder のデータの分析

1. 32 Karat ソフトウェアで、実行からシーケンスを開きます。

2. 最初の実行用にデータファイルを開きます。

3. File > Open > Method をクリックし、ANALYSIS - RNA 9000 - ssRNA Ladder を選択、
OK をクリックします。

参考までに、積分パラメータと名前付きピークの表を次の図に示します。

図 13 : 積分パラメータ

注: ピーク名は、ssRNA Ladder の RNA の長さに対応します。
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図 14 : 名前付きピーク表

4. 統合イベントを調整し、テストサンプルのすべてのピークを正しく統合します。

次の章を参照:ドキュメントの「統合」: メソッド開発ガイド。

5. File > Save をクリックして、メソッドを保存し、ssRNA Ladder サンプルを含むシーケンス内の
行に適用します。
エレクトロフェログラムには、ssRNA Ladder のコンポーネントのピーク名が付けられていま
す。

図 15 : ssRNA Ladder のエレクトロフェログラムの例

合格基準作成のためのガイダンス

SOP またはその他の目的でこのキットを使用するために作成される合格基準は、分離の品質に固
有のパラメータと、重要なサンプルの品質を反映する属性に基づく必要があります。ゲルとキャピラ
リーのロットの違いや装置の違いにより、絶対移動時間にばらつきが生じる可能性があります。
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ssRNA Ladder の場合、9 kb と 0.5 kb のピークの移動時間の比は、ゲル内の核酸の見かけの大
きさをより正確に反映し、分離ゲルの分解能や分離の一貫性を特定するために使用することができ
ます。SCIEX は、絶対的な移行時間を合格基準として使用することを強く推奨しません。

トラブルシューティング

注: SYBR™ は、Life Technologies Corporation の商標です。SYBR™ Green II RNA Gel Stain は
再販不可です。

症状 考えられる原因 修正アクション

ピークのブロード化、
分解能の低下

1. キャピラリーの端が損傷してい
る。

2. サンプル濃度が高すぎる。

3. キャピラリーが詰まっている。

4. キャピラリーの内面が汚れて
いる。

5. キャピラリーの寿命を超えた。

6. ゲル緩衝液の SYBR™ Green
II RNA Gel Stain 濃度が高す
ぎる。

1. キャピラリーの端を拡大して検査
します。断面がギザギザになって
いる場合は、端を再度カットする
か、キャピラリーを交換します。

2. 次のいずれかまたはすべてを行
ってください。

• サンプルをサンプル希釈液で
再び希釈します。

• 分離メソッドの Inject イベント
の Duration を減らして、注
入するサンプルを減らします。
満足のいく結果が得られない
場合は、Pressure または
Voltage を下げます。

3. キャピラリーまたはキャピラリー
カートリッジを交換します。

4. キャピラリーまたはキャピラリー
カートリッジを交換します。

5. ssRNA Ladder のテスト分離を
行います。ピーク幅が常に以前
の測定より一貫して広い場合
は、キャピラリーまたはキャピラリ
ーカートリッジを交換してくださ
い。

6. ゲル緩衝液で SYBR™ Green II
RNA Gel Stain が 100 倍 ～
1000 倍に希釈されていることを
確認します。 次のセクションを参
照: 緩衝液トレイをロードする。
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症状 考えられる原因 修正アクション

ピークのブロード化、
分解能の低下（続
き）

1. Nucleic Acid Extended
Range Gel を室温に長く放置
しすぎた。

2. キャピラリーカートリッジを室温
で 1 週間以上放置した。

1. 新しい Nucleic Acid Extended
Range Gel を用意し、必ず 2 °C
から 8 °C の間で保存します。ゲ
ルを室温に置く時間を最小限に
抑えます。

2. キャピラリーまたはキャピラリー
カートリッジを交換します。新しい
キャピラリーには、その日の最後
に必ずシャットダウンメソッドを実
行してください。

キャリーオーバー 1. サンプル濃度が高すぎる。

2. バイアルまたはキャップが汚
れている。

1. 次のいずれかまたはすべてを行
ってください。

• 分離メソッドの Inject イベント
の Duration を減らして、注
入するサンプルを減らします。
満足のいく結果が得られない
場合は、Pressure または
Voltage を下げます。

• サンプルをサンプル希釈液で
再び希釈します。

2. バイアルとキャップを交換する
か、メソッドを変更します。

• 清潔なバイアルに新たに準備
した試薬を満たし、バイアルを
清潔なキャップでカバーし、ト
レイのバイアルを交換します。
バイアルやキャップを再利用
しないでください。

• 廃液バイアルに 1.0 mL の水
が含まれており、アウトレット
緩衝液トレイにあることを確認
します。

• 分離メソッドでは、サンプル注
入後に 1 つ以上の水浸ステッ
プを追加します。
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症状 考えられる原因 修正アクション

余分なピーク 1. サンプル中の非核酸成分と
SYBR™ Green II RNA Gel
Stain の間に相互作用が発生
した。

2. サンプル調製時に使用したプ
ラスチック器具、またはサンプ
ルバイアルに SYBR™ Green
II RNA Gel Stain と相互作用
する物質が混入しています。

3. ゲル緩衝液で 1μm 以上の微
粒子による光散乱。

1. サンプルを再度調製し、純度に
問題がないことを確認します。

2. 清潔なプラスチック器具と清潔な
サンプルバイアルを使用して、サ
ンプルを再度調製します。バイア
ルやキャップを再利用しないでく
ださい。

3. ゲル緩衝液はシリンジフィルター
でろ過してから、緩衝トレイに入
れてください。

高電流 1. ゲル緩衝液が汚れている。

2. 緩衝液トレイが正しくセットアッ
プされていない。

3. Nucleic Acid Extended
Range Gel を室温に長く放置
しすぎた。

1. バイアルとキャップをきれいなも
のと交換します。 バイアルやキャ
ップを再利用しないでください。

2. 緩衝液トレイ内のバイアルに正し
い試薬が入っており、正しい場所
にあることを確認してください。次
のセクションを参照: 緩衝液トレ
イをロードする。

3. 新しい Nucleic Acid Extended
Range Gel を用意し、必ず 2 °C
から 8 °C の間で保存します。ゲ
ルを室温に置く時間を最小限に
抑えます。
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症状 考えられる原因 修正アクション

低シグナル 1. キャピラリーチップの端が汚れ
ているか、詰まっている。

2. サンプル濃度が低すぎる。

3. サンプルの塩濃度が高すぎ
る。

4. 初期核酸の濃度が低すぎる。

1. キャピラリーまたはキャピラリー
カートリッジを交換します。

2. 次のいずれかまたはすべてを行
ってください。

• 分離メソッドの 注入イベント
の Duration を 15 秒まで上
げて、サンプルの注入量を増
やします。満足のいく結果が
得られない場合は、
Pressure 圧力または
Voltage を上げます。

• サンプルを推奨濃度で再び調
製します。 推奨濃度は
50 ng/mL ～ 50 μg/mL で
す。

3. 次のいずれかまたはすべてを行
ってください。

• 分離メソッドで動電注入を使
用している場合は、代わりに
圧力注入を使用します。

• 低いイオン強度でサンプルを
調製します。

4. 次のいずれかまたはすべてを行
ってください。

• 分離メソッドの 注入イベント
の Duration を 15 秒まで上
げて、サンプルの注入量を増
やします。満足のいく結果が
得られない場合は、
Pressure 圧力または
Voltage を上げます。

• サンプルを推奨濃度で再び調
製します。 推奨濃度は
50 ng/mL ～ 50 μg/mL で
す。

低シグナル（続き） 1. サンプルの核酸は、RNAse ま
たは他のヌクレアーゼの存在
により分解されています。

1. RNase に曝さないようにして、再
度試料を調製します。次のセクシ
ョンを参照: RNA を扱うためのベ
ストプラクティス。
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症状 考えられる原因 修正アクション

低電流 1. キャピラリーチップの端が汚れ
ているか、詰まっている。

2. キャピラリーウィンドウまたは
端が破損している。

3. 電極、開口レバー、キャピラリ
ーの両端、またはインターフェ
ースブロックに乾燥した試薬が
付着している。

4. 緩衝液トレイが正しくセットアッ
プされていない。

1. キャピラリーまたはキャピラリー
カートリッジを交換します。

2. キャピラリーウィンドウとチップを
検査します。どちらかが壊れてい
る場合は、キャピラリーまたはキ
ャピラリーカートリッジを交換しま
す。

3. インターフェースブロックのクリー
ニングは、毎日または必要に応
じて行ってください。次のセクショ
ンを参照: インターフェースブロッ
クをクリーニングする。

4. 緩衝液トレイ内のバイアルに正し
い試薬が入っており、正しい場所
にあることを確認してください。次
のセクションを参照: 緩衝液トレ
イをロードする。

低電流または不安
定な低電流

1. キャピラリーチップの端が汚れ
ているか、詰まっている。

2. ゲル緩衝液に気泡がある。

1. キャピラリーまたはキャピラリー
カートリッジを交換します。

2. 緩衝液を 10 秒～ 20 秒超音波
処理して、気泡を除去します。
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症状 考えられる原因 修正アクション

分離時に電流がな
い

1. キャピラリーが損傷している。

2. 電極が破損しているか、曲が
っている。

3. キャピラリーチップの端が汚れ
ているか、詰まっている。

4. 緩衝液トレイが正しくセットアッ
プされていない。

5. キャピラリーが気泡で満ちてい
る。

6. 電極、開口レバー、キャピラリ
ーの両端、またはインターフェ
ースブロックに乾燥した試薬が
付着している。

1. キャピラリーまたはキャピラリー
カートリッジを交換します。

2. 電極を交換します。

3. キャピラリーまたはキャピラリー
カートリッジを交換します。

4. 緩衝液トレイ内のバイアルに正し
い試薬が入っており、正しい場所
にあることを確認してください。次
のセクションを参照: 緩衝液トレ
イをロードする。

5. 次のいずれかまたはすべてを行
ってください。

• Microvial に 100 μL のサンプ
ルが入っていることを確認し
ます。

• 緩衝液トレイとサンプルトレイ
のバイアルが正しい位置にあ
ることを確認してください。次
のセクションを参照: 緩衝液ト
レイをロードするおよびサンプ
ルトレイのロードを参照。

• 緩衝液を 10 秒～ 20 秒超音
波処理して、気泡を除去しま
す。

6. インターフェースブロックのクリー
ニングは、毎日または必要に応
じて行ってください。次のセクショ
ンを参照: インターフェースブロッ
クをクリーニングする。
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症状 考えられる原因 修正アクション

ピークなし 1. レーザー誘導蛍光検出器レー
ザーの寿命を超えた。

2. メソッドパラメータが正しくな
い。

3. サンプルバイアルの底に気泡
がある。

4. キャピラリーウィンドウまたは
端が破損している。

5. サンプル量が少なすぎる。

6. サンプルがないか、サンプルト
レイの正しい位置にない。

7. キャピラリーを 0.1 N NaOH
などの塩基性溶液で洗浄し
た。

8. キャピラリーの端が電極を越
えて伸びている。

1. SCIEX テクニカルサポート
（sciex.com/request-support）ま
でお問い合わせください。

2. 次を実行します。

a. ソフトウェアで分離メソッドを
開き、メソッドが正しいことを
確認します。次のセクション
を参照: 分離メソッド。

b. トレイ内のサンプルや試薬
の位置が、トレイレイアウト
と一致していることを確認し
ます。

3. 遠心分離機を使用してサンプル
チューブを回転させ、底に気泡が
ないことを確認します。

4. キャピラリーウィンドウとチップを
検査します。どちらかが壊れてい
る場合は、キャピラリーまたはキ
ャピラリーカートリッジを交換しま
す。

5. Microvial に 100 μL のサンプル
が入っていることを確認します。

6. サンプルがサンプルトレイの正し
い場所にあることを確認します。
次のセクションを参照: サンプル
トレイのロード。

7. キャピラリーまたはキャピラリー
カートリッジを交換します。

8. キャピラリーの端を拡大して検査
します。端が電極を越えて伸びて
いる場合は、端を再度カットする
か、キャピラリーを交換します。
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症状 考えられる原因 修正アクション

ピークなし（続き） 1. サンプル調製時にピペッティン
グエラーが発生した。

2. サンプルの塩濃度が高すぎ
る。

1. 次のいずれかまたはすべてを行
ってください。

• 分離メソッドで動電注入を使
用している場合は、代わりに
圧力注入を使用します。

• 低いイオン強度でサンプルを
調製します。

2. 新しいサンプルを調製します。

同時低電流の有無
にかかわらず、移動
時間を短縮

1. キャピラリーチップの端が汚れ
ているか、詰まっている。

1. キャピラリーまたはキャピラリー
カートリッジを交換します。

同日の実行間にお
ける移動時間の劇
的な変化

1. キャピラリーの調整が十分で
ない。

2. ゲル緩衝液が蒸発した。

1. キャピラリーを調整します。 次の
セクションを参照: キャピラリーの
調整。ブランク分離を行い、キャ
ピラリー内表面を平衡化させま
す。

2. 清潔なバイアルに新たに準備し
た試薬を満たし、バイアルを清潔
なキャップでカバーし、トレイのバ
イアルを交換します。 バイアル
やキャップを再利用しないでくだ
さい。

エレクトロフェログラ
ムのスパイク

1. ゲル緩衝液に気泡がある。 1. 緩衝液を 10 秒～ 20 秒超音波
処理して、気泡を除去します。 気
泡が残っている場合は、新しい
ゲル緩衝液を用意します。ボル
テックスミキサーで混合せず、チ
ューブを 20 回以上静かに反転
させます。
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症状 考えられる原因 修正アクション

ピークが広い、また
は分割されている

1. 変性後、核酸サンプルが二次
構造を保ったままである。

2. 変性後の冷却ステップが遅す
ぎた。

3. ゲル緩衝液の SYBR™ Green
II RNA Gel Stain 濃度が高す
ぎる。

4. キャピラリーの寿命を超えた。

1. ヌクレアーゼフリー水の代わりに
Sample Loading Solution で希
釈します。

2. 二次構造の形成を防ぐため、サ
ンプルは直ちに冷却します。

3. ゲル緩衝液で SYBR™ Green II
RNA Gel Stain が 100 倍 ～
1000 倍に希釈されていることを
確認します。次のセクションを参
照: 緩衝液トレイをロードする。

4. ssRNA Ladder のテスト分離を
行います。ピーク幅が常に以前
の測定より一貫して広い場合
は、キャピラリーまたはキャピラリ
ーカートリッジを交換してくださ
い。

ピークが飽和状態 1. 分離メソッドの LIF Detector
Initial Conditions では、
Dynamic range が小さすぎ
ます。

2. サンプル濃度が高すぎる。

1. Dynamic range の値を大きくし
ます。

2. 次のいずれかまたはすべてを行
ってください。

a. サンプルをサンプル希釈液
で再び希釈します。

b. 分離メソッドの Inject イベン
トの Duration を減らして、
注入するサンプルを減らしま
す。満足のいく結果が得ら
れない場合は、Pressure
または Voltage を下げま
す。

ベースラインが不安
定

1. インレット緩衝液トレイの色素
濃度とアウトレット緩衝液トレイ
の濃度が異なる。

1. インレット緩衝液トレイとアウトレ
ット緩衝液トレイの両方に対して
十分なゲル緩衝液を作ります。

RNA 9000 Purity & Integrity キット

RNA 9000 Purity & Integrity キット PA 800 Plus
Pharmaceutical Analysis システム用
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有害物質情報 A
以下の情報に注意し、関連する安全対策を講じる必要があります。詳細な情報については、それぞ
れの安全データシートを参照してください。安全データシートは、ご要望に応じて提供していますが、
当社のウェブサイト sciex.com/tech-regulatory からダウンロードすることもできます。

HCS 2012 による危険物分類。

Acid Wash/Regenerating Solution（0.1 M HCl）

危険! 重度のやけどおよび目の損傷を引き起こします。

SYBR™ Green II RNA Gel Stain4

警告! 可燃性の液体。皮膚炎を引き起こします。

その他の試薬

これらのコンポーネントは有害物質として分類されていません。

• CE Grade Water

• LIF Performance Test Mix

• Nucleic Acid Extended Range Gel

他のベンダーの試薬については、使用前にベンダーの安全性データシートをお読みください。

4 SYBR™ は、Life Technologies Corporation の商標です。SYBR™ Green II RNA Gel Stain は再販不可です。

有害物質情報
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メソッド B
キャピラリーコンディショニングメソッド

図 B-1 : Initial Conditions タブ

メソッド

RNA 9000 Purity & Integrity キット PA 800 Plus
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図 B-2 : LIF Detector Initial Conditions タブ

図 B-3 : Capillary Conditioning Method Time Program タブ

メソッド
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分離メソッド

図 B-4 : Initial Conditions タブ

図 B-5 : LIF 検出器の初期条件

メソッド

RNA 9000 Purity & Integrity キット PA 800 Plus
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図 B-6 : 動電注入の分離メソッド時間プログラムタブ

シャットダウンメソッド

図 B-7 : Initial Conditions タブ

メソッド

アプリケーションガイド
RUO-IDV-05-13437-JA-C

RNA 9000 Purity & Integrity キット PA 800 Plus
Pharmaceutical Analysis システム用

39/49



図 B-8 : LIF Detector Initial Conditions タブ

図 B-9 : シャットダウンメソッド Time Program タブ

メソッド
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キャピラリーリンスメソッド

図 B-10 : Initial Conditions タブ

図 B-11 : LIF Detector Initial Conditions タブ

メソッド
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図 B-12 : Capilllary Rinse Method Time Program タブ

メソッド
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レーザー誘導蛍光検出器のキャリブレー
ション C
新しいキャピラリーまたは別のカートリッジを取り付けた後、または LIF 検出器を取り付けた後に、
LIF 検出器をキャリブレーションします。

試薬

• LIF Performance Test Mix

• Capillary Performance Run Buffer A

• CE Grade Water

1. PA 800 Plus システムの電源を切り、LIF 検出器を取り付けます。

2. PA 800 Plus システムの電源を入れ、レーザーが暖まるまで少なくとも 30 分間待ちます。

3. 32 Karat ソフトウェアを開きます。

4. Tools > Enterprise Login をクリックし、管理者権限を持つユーザーとしてログインします。

5. RNA 9000 装置アイコンをクリックし、Configure > Instrument を右クリックします。
Instrument Configuration ダイアログが開きます。

6. Configure をクリックします。
PA 800 Plus System Configuration ダイアログが開きます。

7. 右側のペインで LIF Detector アイコンをクリックし、右クリックして Open を選択します。
PA 800 plus System Instrument Configuration ダイアログが開きます。

レーザー誘導蛍光検出器のキャリブレーション
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図 C-1 : PA 800 plus System Instrument Configuration ダイアログ

8. LIF Calibration Wizard をクリックします。

9. キャリブレーションを行います。

a. Auto をクリックし、Next をクリックします。

b. Target RFU フィールドに、40を入力します。

c. Capillary dimensions 領域の値が正しいことを確認してから、Next をクリックします。

レーザー誘導蛍光検出器のキャリブレーション
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図 C-2 : キャリブレーションウィザード - ステップ 2

10. バイアルを充填してから、キャリブレーションを開始します。

バイアル位置については、次の図を参照: 図 C-3。

a. ユニバーサルバイアルを緩衝液の位置に入れ、1.5 mL の Capillary Performance Run
Buffer A を充填した後、バイアルにキャップをします。

b. ユニバーサルバイアルをキャリブレーションミックスの位置に入れ、CE Grade Water で
1:1 に薄めた LIF Performance Test Mix 1.5 mL を加え、バイアルにキャップをします。

c. ユニバーサルバイアルを廃液の位置に入れ、1.0 mL の CE Grade Water を充填した
後、バイアルにキャップをします。

d. Next をクリックします。

レーザー誘導蛍光検出器のキャリブレーション
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図 C-3 : キャリブレーションウィザード - ステップ 3

キャリブレーションが完了すると、Calibration Wizard - Step 4 ダイアログが開きます。

11. Calibration Correction Factor の値を調べて結果を評価します。

• 数値が 10 未満であれば、キャリブレーションは成功です。Accept をクリックして結果を保
存し、キャリブレーションウィザードを閉じます。

• 数値が 10 を超える場合は、Cancel をクリックします。次のセクションを参照: LIF 検出器の
キャリブレーションの CCF 値。

図 C-4 : キャリブレーションウィザード - ステップ 4

12. Direct Control を使用して、サンプル保存温度を 10 °C に設定します。

レーザー誘導蛍光検出器のキャリブレーション
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LIF 検出器のキャリブレーションの CCF 値
報告済み CCF 値 アクション

0.1 未満
または

システムパフォーマン
スが許容できない

• 正しいキャピラリーが使用されていて、キャピラリーが破損していない
ことを確認します。

• PA 800 Plus システムで使用されているレーザーのレーザー出力を
確認します。

• LIF 検出器に正しいフィルターが取り付けられていることを確認しま
す。

• 励起: 488 nm

• 発光: 520 nm

• テスト混合、緩衝液、キャピラリーを交換し、キャリブレーションを繰り
返します。問題が解決しない場合は、SCIEX テクニカル サポート
(sciex.com/request-support) にお問い合わせください。

0.1 〜 10.0 システムに問題がありません。標準を実行し、システムのパフォーマンス
が満足できるものであることを確認します。

10 超
または

システムパフォーマン
スが許容できない

• PA 800 Plus システムで使用されているレーザーのレーザー出力が
正しいことを確認します。

• LIF 検出器に正しいフィルターが取り付けられていることを確認しま
す。

• 励起: 488 nm

• 発光: 520 nm

• テスト混合、緩衝液、キャピラリーを交換し、キャリブレーションを繰り
返します。問題が続行する場合は、SCIEX テクニカル サポート
(sciex.com/request-support) にお問い合わせください。

レーザー誘導蛍光検出器のキャリブレーション
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お問い合わせ先

お客様のトレーニング
• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター
• SCIEX Now Learning Hub

消耗品と試薬の購入
SCIEX の消耗品と試薬は store.sciex.com からオンラインでご注文いただけます。ご注文の場合
は見積書、注文確認書、または発送書類に記載されているアカウント番号をお使いください。現在
は、米国、英国、ドイツのお客様がオンラインストアにアクセスできますが、今後、他の国にもアクセ
スを拡大する予定です。米国、英国、ドイツ以外のお客様は、地域の SCIEX サービス担当者まで
ご連絡ください。

SCIEX サポート
SCIEX およびその代理店は、十分に訓練を受けた保守/技術専門要員を世界中に配置していま
す。システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報について
は、SCIEX web サイト (sciex.com) を参照するか、以下の連絡先までお問い合わせください。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ
SCIEX 製品のサイバーセキュリティに関する最新のガイダンスについては、sciex.com/
productsecurity を参照してください。

ドキュメント
このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するには Adobe Acrobat Reader が必要です。最新バージョンを
ダウンロードするには、次にアクセスしてください https://get.adobe.com/reader 。

ソフトウェア製品のドキュメントについては、ソフトウェアに付属のリリースノートまたはソフトウェアイ
ンストールガイドを参照してください。

お問い合わせ先
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ハードウェア製品のマニュアルについては、システムまたはコンポーネントに付属の説明書を参照し
てください。

ドキュメントの最新版は SCIEX の web サイト（sciex.com/customer-documents）で入手できま
す。

注: このドキュメントの無料の印刷版を請求するには、sciex.com/contact-us までお問い合わせくだ
さい。

お問い合わせ先
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